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PURPOSE OF THIS TRAINING

This training is offered through the Places and Flows research line, where geographic data
analysis plays a central role in researching mobility, urban development, and spatial
patterns. The skills you acquire are not only valuable for teaching, but also directly
applicable to our own research projects

GIS LAB

- Tangible landscape
- Emotion Mapping
- GIS-Analyses

Ondrej Mitas, Paul van de Coevering, Jeroen Klijs, Maciej Czerniak and Sait Durgun



Received topics from your side

What is a useful background in QGIS for creating maps? 2> PLUGINS
What settings should | use to export a map to PDF? ->PLOTLAYOUT

How can | add information that is not in the basic data? —2>JOINING DATA



Today's program:

« GISIN A GENERAL SENSE

« BASIC ELEMENTS (data type, crs, data operations)

« PRACTISING IN QGIS (basic plugins, plot-layout, properties,
attributetabel, processing toolbox, join, symbology)



WHAT IS GIS?

A geographic information system (GIS) is a system that creates,
manages, analyzes, and maps all types of data. GIS connects
data to a map and integrates location data (where things are) with
all descriptive information (how things are there).

GIS helps users understand patterns, relationships, and
geographical context. (ESRI, 2022)



HOW DOES GIS WORK?

Maps x Data x Analysis
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MAPS

Maps are the geographic
container for the data
layers and analytics you
want to work with.

DATA

GIS integrates many
different types of data
layers using spatial
location. Most data has a

geographical component.

GIS data includes images,
features, and basemaps
that are linked to
spreadsheets and tables.

ANALYSIS

Spatial analysis allows you
to evaluate, estimate and
predict, interpret and
understand, and much
more in a correct and
proficient manner,
reinforcing your insight
and decision-making from
a new perspective.
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MAPS DATA ANALYSIS

WY Breda
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Storing data: 2 ways

raster data
urban area

Vector formats:
Accurate representation of reality

Raster formats:
Square cells represent reality

river

vector data

WY Breda
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POINTS, LINES, AND POLYGONS IN
VECTORS

v l [ II |:
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points lines polygons
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STORAGE OF DATA IN THE ATTRIBUTE TABLE

p
N e i h b O r. h O O d S Example Attributes for Point Data
g o 1 ID Plot Size Type VegClass
2 1 40 Vegetation Conifer
- - . = - el
BU_CODE NE_NAME WK_CODE GM_CODE MU_NAME IND_WBI Rt T ) .
» 2 20 Vegetation Deciduous
1 |BUO7581000 Teteringen k075810 GMD758 Breda .3
| o 3 40 Vegetation Conifer
2 |BUO7580909 Buitengebied Pri... WK075809 GMD758 Breda /
3 |BUO7581009 Buitengebied Te... \WK075810 GMO758 Breda ] )
¢ Example Attributes for Line Data
4 |BUQ7581008 Vuchtpolder k075810 GMO0758 Breda —
ID Type Status Maintenance
5 |BUO7580800 Ulvenhout k075808 GMO758 Breda 1
6 BUO7580709 Buitengebied Ba... WK075807 GMO0758 Breda ‘\2/\ 1 Road Open Year Round
7 BUO7580900 Prinsenbeek k075809 GMD758 Breda T Dirt Trail Open Summer
8 BUO7580809 Buitengebied Ul.. \}K075808 GMO758 Breda \\ 3 Road Closed Year Round
4
9 |BUO7580609 Hagebeemd K075806 GMO758 Breda
10|BUO7580607 Emer K075806 GM0758 Breda Example Attributes for Polygon Data
11/BUO7580701 Mieuw Waolfslaar K075807 GMO758 Breda D Type Class Status
12|BU07580700 Bavel k075807 GMO0758 Breda
1 Herbaceous Grassland Protected
13/BUQ7580604 Heksenwiel k075806 GM0758 Breda e
——
14 BUO7580603 Muizenberg KO75806 GMOT758 Breda @ 2 Herbaceous Pasture Open
15BUOT580606 | Kroeten K075806 GM0758 Breda ) 3 Herbaceous /Woody | Grassland Protected
16 BUO7580605 Qverkroeten K075806 GMO758 Breda nean
L -

"W Breda
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EXAMPLE OF AN ATTRIBUTE

NE_NAME NUMB_INH NUMB_MAN  NUMB WOMAN  P_0D_14 YR P 15 24 YR P 25 44 YR P 45 64 YR P 65 AO_YR
1 Valkenberg 1960 960 1000 5 26 32 19 18

N U m be r Of 2 Chassé 3225 1635 1590 8 15 31 23 23
i N h a b |ta ﬂtS, 3 Fellenoord 1590 785 800 10 21 38 21 10
4 Schorsmolen 3400 1755 1645 3 24 42 16 14

n u m be r Of 5 Station 2300 1200 1100 8 21 49 16 6
ma n, number 6 City 2480 1320 1160 3 33 39 17 9
f Belcrum 3990 1980 2005 20 13 34 23 10
O Woma n’ etc' 8 Doornbos-Linie 4365 2255 2105 14 17 35 22 13
9 Biesdonk 5075 2405 2665 17 13 26 24 19

10 Geeren-Zuid 3750 1790 1960 18 13 29 22 18

11 Wisselaar 4210 2050 2160 17 13 25 26 18

12 Krogten 185 100 85 9 15 20 40 16

13 Geeren-Noord 2740 1350 1390 18 11 27 25 19

14 Waterdonken 1225 600 625 EY 5 47 14 3

15 Brabantpark 10095 4750 5345 13 19 29 22 17

WY Breda
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WHERE CAN YOU FIND THIS KIND OF DATA?

Bl -
= craatmwen  @jrostat (opernicus

A,

(N
V%

Open
) Street
- Map

bdok

GEOFABRIK

. Klimaateffectatlas ﬂ?%d Planbureau voor de Leefomgeving
oy 5
C L
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WHAT KIND OF FILE FORMAT SHOULD YOU PAY
ATTENTION TO?

WMS:
The WMS (Web Mapping Service) is an image to look at.

WES:
The WFS (Web Feature Service) is to download the data or
parts of it, after which further processing can be done on

it.

GeoJSON:
GeoJSON is a JSON-based format designed to represent
the geographical features with their non-spatial features.

WY Breda
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COORDINATE REFERENCE SYSTEM (CRS)

| Ginzburg Iv I Ginzburg v I Ginzburg V1 Ginzburg VIIT

PROJECTIONS THAT
HELP TO VISUALIZE ==
AND DESCRIBE
REALITY.

! Gott-Mugnolo Azimuthal (equat.) | Gott-Mugnolo Azimuthal (Hem.)

) Hobo-Dyer - Holzel ) Hufnagel 2 ) Hufnagel 3 -/ Hufnagel 4

Breda

4 University

OF APPLIED SCIENCES




“Practice safe geography: always use a projection”

Lambert
Conformal Conic
Unprojected
= - - Longitude and Latitude
y 4

A

Mercator »Z4 University
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World Mercator projection with true country size added

@neilrkaye MY Breda
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NIEUW NEDERLANDS COORDINATENSTELSEL:
AMERSFOORT RD NIEUW - EPSG 28992

. Amersfoort

Y-as (RD
as ( )1

% (0,600.000) (300.000,600.000)

| _Amersfoort

|
|
(0,300.0007% : (300.000,500.000)

(0,0 o (300.000,0)

X-as (RD)

™ X-as (RD)
WY Breda
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JOINING DATA

@lh ese © Sales_Data.csv
= Toemak: Bacmt: Helpl | Zosked u 2024-12-12;Central;Douglas; John;Television;67;$1 198,00;$80 266,00
m 2024-12-29; East;Douglas;Karen;Video Games;74;$58,50;$4 329,00

2024-01 15;Central;Timothy;David;Home Theater;46;$500,00; $23 000,00

Regionale kerncilfers Nederland i|2l& z s ;Central;Douglas;John;Home Theater;87;$500,00; 00.00
Gewileiod op: $1 okober 2025 8]East;Martha;Alexander;Home Theater;4;$500,00 52 000,00
R S . West;Timothy;Stephen;Home Theater;7;$500,00;$ 00, 00

2024—03-24 Central;Hermann;Luis;Video Games;50;$58,50;$2 925,00
2024-04-10;Central;Martha;Steven;Television;66;$1 198,00;$79 068,00

U bent direct naar de uiste tabel i Nt niewwe Statline gefeid en ziet een st presentatie.

@ te
aanpassen kan door a

lems te kiezen; kiik op het flfe

« Des WD of indeing, 2024-04-27;East;Martha;Diana;Cell Phone;96;$225,00;%$21 600,00
« Hetvastieggenvan eenlink s vesanderd, Doar het delen-icoon. o tabel vastieqt. 2024-05-14;Central; Timothy;David;Television;53;$1 198,00;$63 494,00
2024-05-31;Central;Timothy;David;Home Theater;80;$500,00;$40 000,00
e 2024-06-17;Central;Hermann;Shelli;Desk;5;$125,00; $625,00
e 2024-07-04;East;Martha;Alexander;Video Games;62;$58,50;$3 627,00
v Bevolking Leehiyd e 2024-07-21;Central;Hermann;Sigal;Video Games;55;$58,50;$3 217,50
e v e Seank 2024-08-07;Central;Hermann;Shelli;Video Games;42;$58,50;%$2 457,00
aaota . 10000 ot perknt 2024-08-24;West; Timothy; Stephen;Desk;3;$125,00;$375,00
fedeied i:i :::::: ::: ;: ‘:::: j:j: 2024-09-10;Central;Timothy;David;Television;7;$1 198,00;$8 386,00
i Laosenrr 0 e :m,j,, . 2024-09-27;West; Timothy;Stephen;Cell Phone;76;$225,00;$17 100,00
2 Nedertana (D) 2023 3750577 ne 4 70091 150 2024-10-14;West;Douglas;Michael;Home Theater;57;$500,00;$28 500,00
) i fhard 73 25 mn 13 2024-10-31;Central;Martha;Steven;Television;14;$1 198,00;$16 772,00
e - - ” Tk . 2024-11-17;Central;Hermann; Luis;Home Theater;11;$500,00;$5 500,00
2024 1309083 1 s saz074 1304 2024-12-04;Central;Hermann;Luis;Home Theater;94;$500,00;$47 000,00

2024-12-21;Central;Martha;Steven;Home Theater;28;$500,00;$14 000,00

12.4. Connecting and Editing Data Across Layers — QGIS Documentation documentation U University

OF APPLIED SCIENCES



https://docs.qgis.org/3.40/en/docs/user_manual/working_with_vector/joins_relations.html
https://docs.qgis.org/3.40/en/docs/user_manual/working_with_vector/joins_relations.html
https://docs.qgis.org/3.40/en/docs/user_manual/working_with_vector/joins_relations.html
https://docs.qgis.org/3.40/en/docs/user_manual/working_with_vector/joins_relations.html

JOINING DATA

Add Vector Join

1. Go tothelver QRN <@ W b [ addveorson O
2. Click the efa Addnewioin bytton, The [Addvectorjomn) dialog appears.

3. Select the [sinlayer) you want to connect with the target vector layer

4. Specify the [UBifield) (from the join 1ayer ) and the [argetfield] (from the target 1ayer ). These are the fields that are used to find matching feature in both
layers hence they should have values in common. Target field 1.2¢at

5. Press [J0KJ and a summary of selected parameters is added to the (B8] panel.

Join layer ~trees |

Join field 1.2cat - |

v Cache join layer in virtual memory
Create attribute index on join field

Layers T @ Layer Fropertcs - Gemeenten — ois

¢ § e TV &-B AL

Gemegiy
= v 3 osmq - Zoom to Layerfs)

— Dynamic form
w | | Editable join layer

G e Vertor Join x
Zoom to Selection
omlarer
ﬂ?, Show in Qverview Jom fakd
Show Feature Count . ]
¥ Cacha join s i mamary
=4 Show Labels (Cruste siribute inlex an join feld
Copy Layer Oymamc o v v Jolned Fields
Statistics | Repame Layer | ¥ Rt
= L] Duplicate Layer L e M cat
S — v VEGDESC
Remove Layer...
Statistic v VE67|D
T | M tofotom F_CODEDESC
= Open Attribute Table F-CODE
Filter.. v AREA_KM2

Change Data Source...

Set Layer Scale Visibility.. v Custom Field Name Prefix

Layer CRS ' b L] cumtom i pama protx
Bpon : o |
Styles 4
Add Layer Notes... ® gancel JQK
Properties...

Fig. 12.105 Join an attribute table to an existing vector layer

Breda
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IMPORTANT CONSIDERATIONS JOINING DATA

+ Check matching values - Ensure values to be joined match exactly in both datasets (e.g., "Amsterdam" in both, not
"Amsterdam" vs "A'dam")
«  Watch for spaces in cells - Remove leading/trailing spaces in CSV files, these are often invisible but disrupt the join
+ Case sensitivity - Check that values are consistent in capitalization ("Nederland" vs "nederland" won't match)
« Data type consistency - Ensure join fields have the same data type. For example:
 Postal code "1234AB" (text) vs 1234 (numeric)
«  Municipality code "GM0263" (text) vs 263 (numeric)
* Province code "PV25" (text) vs 25 (numeric)
« CBS code "GM0263" (text) vs "0263" (text)Pay special attention to codes starting with zeros!
+ Empty values and NULL - Check how empty cells are handled; NULL is not the same as an empty string "
« Special characters - Watch for accents, umlauts and other diacritical marks (&, &€, fi) that may be encoded differently
+ Encoding issues - Preferably use UTF-8 encoding for both files to prevent character problems
« Duplicates in join field - Check for duplicate values in the join field, this can produce unexpected results
» Preview join results - Always verify how many records successfully joined and investigate non-matched records



GEOPROCESSING

INPUT

Union

INTERSECT
FEATURE

¥

ouTPUT

Intersect

Identity

Clip

Dissolve

A4
4
ouTPUT

Merge

Buffer

28.2.7. Vector geoprocessing — QGIS Documentation documentatie

WY Breda
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A FEW EXAMPLES OF WHAT THE STUDENTS LEARN

Analyse elevation map

Service area

Switzerland's regional income (in-)equality

Average yearly income and income (in-)equality in Swiss municipalities, 2015

Grey areas mean
low income and

low inequality
¥

“\. Blue areas mean
high income and
low Inequality

Violet areas mean
high income and
high Inequality

Red areas mean
fow income and
high inequality

Bivariate map

WY Breda
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Plugins

* OpenTopography DEM Downloader = Digital Elevation Model

« PDOK SERVICES PLUGIN = Largest data collection repository in the netherlands
* QUICKOSM= Open Source data collection Open Street Map

* QUICKMAPSERVICES - Basic background maps

WY Breda
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BACKGROUND INFORMATION

# QGIS Documentation

#  QGIS Trainingshandleiding

© Vorige

O Belangrijk

patial Analysis T o i | pS: //docs. q gi s.org /3.4
WITH GIS e QGIS Trainingshandleiding 0/nl/docs/training_manu

2. Module: Een basiskaart maken
en verkennen « 1. Introductie voor de cursus

i P al/index.html
Toolkit for Smarter - 1.2, Over de vefeningen

4. Module: De kaarten opmaken

« 2. Module: Een basiskaart maken en verkennen

5. Module: Vect
URBAN MAPPING maen « 2.1. Les: Een overzicht van de interface

6. Module: Vectoranalyse o 2.2. Les: Uw eerste lagen toevoegen
7. Module: Rasters o 2.3. Les: Navigeren in het kaartvenster

B Mcrkde: U wntyes o 24, Les: Symbologie

completeren « 3. Module: Vectorgegevens classificeren

9. Module: Plug-ins
o 3.1. Les: Vector attributengegevens
o 3.2. Les: Labels

11, Module: QGIS Server > 3.3. Les: Classificatie

12. Module: GRASS

10. Module: Online bronnen

+ 4 Madule: Na kaarten anmalen

Learn GIS - QGIS Full Course for Beginners (New for 2025) H

434K views + 1 year ago

e Matt Forrest

Get a FREE QGIS CERTIFICATION for watching this video here!
cc

_ 25 chapters Intro | Welcome to QGIS | Installing QGIS | Finding GIS data | Adding vector layers | Adding a... v

1:12:46

"W Breda

WIWW.URSANDESICHLABIN
Expilore the new avenues of Urban environment

Learn GIS - QGIS Full Course for Beginners (New for 2025) 74 University
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WATCHING TUTORIALS

LEARNING BY DOING

WY Breda
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QGIS Quick Manual

Basic GIS Training

This manual summarizes everything we practiced during the training:

* Adding PDOK Services

* Using QuickMapServices

e Selecting the correct CRS for the Netherlands

* Adding municipality (gemeente) boundaries

* Creating a map of Amsterdam with layout elements (legend, scale bar, north arrow)

* Exporting to PDF

WY Breda
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QGIS Quick Manual

Basic GIS Training

1. Add PDOK Services Plugin In QGIS top menu » Plugins » Manage and Install Plugins

(2 *Untitled Project — QGIS

— o X
Project Edit View Layer Settings Vector Raster Database Web Mesh Processipg 9

NEERR B Be LN OR fH-o-B-G- 65 %3

i @ python Console Ctrl+Alt+P
BEV. A WMEBE T e | 0o -
Browser

LT X0

‘ﬁg’ Favorites =
y [ Spatial Bookmarks
v [&] Home
v [ €\ (Windows)

@ GeoPackage

Manage and Install Plugins...

- i - -

f Spatialite

‘ PostgreSQL |

il CAD LIANIA b
Layers B

@l ® TV 5 -@ LD

WY Breda

| Q, Type to locate (Ctrl+K)

. L]
— vZ4 University
Coordinate | 1247224, -5481700 |% Scale|1:2223115 - & Magniﬁer‘_'\[)()% |:‘ Rotation | 0.0° ¢J v Render ¥EPSG28992 @@
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QGIS Quick Manual

Basic GIS Training

1. Add PDOK Services Plugin

@ *Untitled Project — QGIS
Project Edit View Laye

NEERS Y
L LAFXY )

Settings Plugins Vector Raster Database Web Mesh

Y

Processing Help

RIEALBLEODOR

1-Search for PDOK Services Plugin

Browser
(@ Plugins | Installed (10)

LT *O

<M H
7.0 Favorites

| Q dek

v [["] Spatial Bookmarks
» [&5] Home
» [ C\ (Windows)
@ GeoPackage
f Spatialite
' PostgreSQL

i cAp LANA

i Installed

Not installed
Invalid

Layers

v @l ® T 5~

Install from ZIP

ﬁ Settings

3- After installation
PDOK will appear on
the Plugins menu

PDOK services
plugin

Plugin to easily load the available
Dutch PDOK (Publieke
Dienstverlening Op de Kaart)
services. Currently only in Dutch.

Nederlands:

- Plugin om eenvoudiger PDOK services
(WMS, WMTS, WFS, WCS en OGC:API
tiles/features) te laden in QGIS.

- Handig? Doneer een koffie of borrel via
https://liberapay.com/rduivenvoorde/

- Een paar opmerkingen: alle dataset en de ~
Average rating 4.4, 130 rating vote(s), 313989 do ads
Your Vote : - - j—l Votel! |

Upgrade All ‘

Install Plugin |

2-Click Install Plugin

1

[ Close ] | Help |

W Breda

| Q Type to locate (Ctrl+K)

Coordinate | -1233107, -5485229 g Scale | 1:2223115 |~ | @@ Magnifier 100% |= Rotation | 0.0°

’/’ University
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QGIS Quick Manual

Basic GIS Training
2. Add Base Maps Using QuickMapServices p|ugins > Manage and Install Plugins

(2 *Untitled Project — QGIS
Project Edit View Layer Settings Vector Raster Database Web Mesh Processing

NEHBRE ‘.Py’th Consol Ctrl+Alt+P L_%!g@@ 3 b M ¥ Z e )
BEVo/ZAwmBY : RQEQ 2

% > |Zoek in PDOK Locatieserver

Manage and Install Plugins...

PDOK Services Plugin

Browser ]
LT ®TO

57 Favorites =
v [ Spatial Bookmarks
v [&] Home

y [ G\ (Windows)
@ GeoPackage
f Spatialite
‘ PostgreSQL
i SAP HANA
5 STAC
P Ms saL Server
@ Oracle

b 6B WMS/WMTS

O N al P |

Layers

v e T -#AD

WY Breda

. L]
4 University
| Q Type to locate (Ctrl+K) Coordinate | -1473886, -5537157 |% Scale|1:23?9865 | @ Magniﬁer‘TOO% |:‘ Rotation | 0.0° ¢J V| Render & EPSG:28992 Q@ OF APPLIED SCIENCES




2. Add Base Maps Using QuickMapServices

 *Untitled Project — QGIS

Project Edit View Layer Settings Plugins WVector Raster Database

Y1
WOV ARED .

b

NEERRY [

Web Processing Help

QGIS Quick Manual

Basic GIS Training

1-Search for QuickMapServices

}B Ea tBOR

% * |Zoe|< in PDOK Locatieserver

Browser & % All
(o]

LT HO
5'¢ Favorites I" : el
" spatial Bookmarks e

Not installed

v [& Home
y [] €\ (Windows) /
@ GeoPackage '_'_ Invalid
f Spatialite
@ Postgresal 3 Install from ZIP
i SAP HANA

@) STAC # Settings

P MS sQL Server

@ Oracle
» 6B WMS/WMTS
5 Cland b
Layers B X
o @l ® T, ~ A & ]

3- After installation it
will appear on the
Web menu

‘ Q. quickmapservices [ x] |
3 MapTiler ,
% QuickMapServices = -
% RockyCron QuickMapServices
Easy to add basemaps and
geoservices

Easy to use list of services and search for
finding datasets and basemaps. Please
contribute new services via https://
gms.nextgis.com. Developed by NextGIS.
Any feedback is welcome at https://
nextgis.com/contact

Tags wfs, wms,

2-Click Install Plugin

- /
man_Acm

Average rating 4.6, 3408 rating vote(s), 9783634 doyeffoads

Your Vote : . . ‘ () Vote! ‘
Upgrade All ‘ Install Plugin ‘
‘ Close ‘ | Help ‘ Breda

| Q, Type to locate (Ctrl+K)

D U
r/ niversity
Coordinate | -1604543, -5455614 | ¥ Scale 1:2379865 |~ @ Magnifier 100% < Rotation |0.0° 4| V| Render @EPsG28992 @ @A D DEE DA




QGIS Quick Manual

Basic GIS Training

3. Add Base Maps Using QuickMapServices Then go to Web > QuickMapServices and
— pick a basemap:> OSM Standard etc.

(2 *Untitled Project — QGIS = a X
Project Edit View Layer Settings Plugins Vector Raster Database w Processing Help

DB BRRYE QPSR el B QD 0GBy QBT EP

E‘ 2gis b
Q@%%ﬁ% . - - @AutoNavi » lq < @@@ p>
% b ‘Zoek in PDOK Locatieserver | z;r:? :
Browser X 1 GeoQ 4
= < ? B s Google »
A Favori 2 .
o SZ\;(zirz;tlegookmarks g:rebwe@’ '  / Note: If you do not have all the basemap options (Google, ESRI,
v [3] Home apbox » . . . .
By C tindows o Catont X QSM, etc.) in QU|ckI.VIapSerV|ce§. .
? GeoPackage = BasemapAT b ¢ Goto Web » QuickMapServices 2 Settings
Spatialite F .
() pgstg,em ~& Stamen » ¢ Openthe tab More services
I AP HANA vses ' ¢+ Click Activate (this will unlock the full list of services)
15 STAC £ Waze »
: giZSLSENer 9 Yandex » -
» 6B WMS/WMTS P& osm »| P8 OSM Standard
Lay;r\s o = €€}) Search NextGIS QMS , OpenTopoMap
{@ Add to Search Openstreetmap Switzerland (LV95)
o [ @ ~ 5 &
@ - ?L } L {@ Set proper scale ;)‘ Openstreetmap tracks
{@ Settings E Waymarked Trails: Cycling
{Eﬁ About QMS Waymarked Trails: Hiking
E Waymarked Trails: Winter Sport Slopes
@ wikimedia Map
&¥ Opnvkarte }\.\. BIEda

. L]
_ R— 4 University
| Q Type to locate (Ctrl+K) Coordinate | 1520475, 5331681 |9 Scale 12379865 |~ {@f Magnifier| 100% 2| Rotation |00° 3| V| Render @epscassr: @ OF APPLIED SCIENCES




QGIS Quick Manual

Basic GIS Training
3. Set the Correct CRS for the Netherlands
@ “Untitled Project — QGIS

— 1-Click current CRS

D = . . @ Ha O PrOJectPro;:ame:—C:; - B uzf\s __, I:f o A_ _f t‘l R—s '\i © EP;G_ \2_8\992
P earch 1or > Amerstoor ew —
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B = =0 e [ B8]
% v |ZOE‘|< in PDOK Locatieserver . Eze No CRS for unknoun/non-£arth projecy
< Filter | . 28992 al b
Browser a8 % Metadata
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~ a
. i [E View Settings Befarenca Systam Authaority 1D /
' @7 ;"""O_r'tle; - 28992 - Amersfoort / RD New EPSG:28992
patial Bookmarks

} [&] Home
b [ €\ (Windows) PR 7 :

ej GeoPackage wgs Iransformations

: ipatlaU;ZL -/ Styles Predefined Coordinate Reference Systems Hide deprecated CRSs

ostgre S

(i SAP HANA Coordinate Reference System Authority 1D -

@ STAC Colors Amersfoort / RD New EPSG:28992

P Ms saL Server <

@ Oracle Data Sources 1 »
b @ WMS/WMTS Amersfoort / RD New .

5 Fland Relations o " 4' Cl.IC k Apply

roperties

Layers ol P :
o @ & T ' N g Variables ® Units: meters

5- Click OK

® Static (relies on a datum which is plate-fixed)
® Celestial body: Earth
* Method: Oblique Stereographic Alternative

v V| B OSM Standard

WKT
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4. Add the municipality boundaries layer

(2 *Untitled Project — QGIS X == o X
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@ GeoPackage
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4. Add the municipality boundaries layer

Q@ *Untitled Project — QGIS = (u] X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
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f Spatialite N : £ ¥
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il SAP HANA " =
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I MS QL Server Featuretype (WFS) - Gemeenten I S
@ Oracle P
y € WMS/WMTS Name 2
& Cloud bestuurlijkegebieden:Gemeentegebied 4' Cl.le Standaard
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4. Add the municipality boundaries layer

(2 *Untitled Project — QGIS = (u] X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
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HH Vector Tiles +
v i XYZTiles v]
Layers ]
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4. Add the municipality boundaries layer

(2 *Untitled Project — QGIS = o X

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
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NEERRY UL HDDI
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*
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e GeoPackage
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f Spatialite
R L
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T STAC oV Color |
2l Open Attribute Table | N 2D View
P Ms sqL Server % - Opacity
. Oracle Filter... B Diagrams |
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4. Add the municipality boundaries layer

@ *Untitled Project — QGIS = o X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
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4. Add the municipality boundaries layer

g
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4. Add the municipality boundaries layer
a-)“Cut out” Amsterdam > make a new layer

(2 *Untitled Project — QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mes
Gemeenteaneatures Total: 342, Filtered: 342, Selected: 1

IEBREH Q@ ALBPP 54 unes arorraer consaas
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¢ @ ® " = ¥ e
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4. Add the municipality boundaries layer
a-)“Cut out” Amsterdam > make a new layer
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4. Add the municipality boundaries layer
a-)“Cut out” Amsterdam > make a new layer

(X *Untitled Project — QGIS
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Plugins Vector Raster Database Web Mesh Processing Help
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@ Oracle
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HH Vector Tiles
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Export
Styles
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4. Add the municipality boundaries layer
b-) Give Amsterdam a clear style (optional but nice for the PDF)

o *basic gis training manual — QGIS = O

N EERRY PSS HPP Y . RELNOR H 8 G h QE#EE =
@RV ZMBEB /. /) - T S S

= Single Symbol
% v |Zoek in PDOK Locatieserver

Browser B X
W V Layer Exported: Successfully saved vector layer

Q e ? = i ) & symbology alle

= [JFn

— Simple Line

57 Favorites 2
» [ Spatial Bookmarks S
» [ Project Home VogRsarorden Symbol layer type| Outline: Simple Line >
» [ Home o | - <. f
» [ G\ (Windows) Stroke width | 0.660000 @ |2 | Millimeters  ~ | L Sl
f? GeoPackage = Aot E - . 0000000 2| [ Milimeters — + | L ‘{'/ )y
Layers B ® Stroke style | —— Solid Line - & V&~ r/
e V"B A A joinstle | By Bevel -l e \L )“L 2N
v . Amsterdam Cap style LR e VN"-\*I\?',\,«‘\'" \ s ; ..,.N{.'-
» CR Gemeenten / (e EmcE - ) o 77|
v V| & OSM Standard { e (e
Den N3G, Pattem offset | 0.000000 2| [mitimeters  + | €S \ "\ ) ’:L
1-Right-click Amsterdam - Properties Go to Symbology B 7SO

w Trim Lines

2- Choose a Single Symbol style: Set the fill/outline
settings as you wish.
3- Click Apply » OK

Start | 0,000000 2| Milimeters | €S,

End |0.000000 < Millimeters

P Layer Rendering

- Style - oK Cancel Apply Help
0 adoge ;»""‘ \T\%N\?c pen £ o ‘-:‘.'«mf{ Y [’“’“'Q{" "{:\.«ﬂu (% ) f d
Amsterdam now stands out clea\ly on the map Sl ST W 7‘, NP ek S Bre a
\ X A Lt Y \\1 PPIREA 5 ol ) il iy . ’,/
, University
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5. Create a map layout

1.Top menu > Project > New Print Layout... 7

2.Give it a name, e.g. Amsterdam_Map, click OK =

3.In the layout window toolbar, click Add Map — N

4.Drag a rectangle on the page where you want the map > the Amsterdam map appears e :

inside ﬁlu . Libih o %

o - P O A A Undo Histry

fﬁote: Whatever you see in the main QGIS window is what will appear inside the\ 5 -

rectangle you draw in the Print Layout. -

So if the map looks zoomed out, too close, or shows extra layers you don’t want: . [

> first adjust the map view in the main QGIS window i =

(zoom, move, turn layers on/off, change styling) o

Then: AE Ex

> go to Print Layout and draw the rectangle again A

\@capture the updated view.

Optional:

- You can add map elements to improve your layout:
Title, scale bar, north arrow, legend etc. add as many as you like.
All are available from Add Item in the Print Layout toolbar.
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6. Export the map as PDF

@ *amsterdam map

1- In the layout window top menu - Layout > Export as PDF...

2- Choose afolder and file name, e.g. Amsterdam_Map.pdf %
| A
Click Save S
Done! Bl
You now have a PDF map of Amsterdam clipped from the Gemeenten layer. a 2 S

T] Amsterdam Map
'l Map 1

Layout | ltem Properties | Guides
Item Properties

page: 1 37.8%

WY Breda
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That’s it for the first Basic GIS Training!

The best way to learn GIS is to play around, explore, and experiment so don’t hesitate to try
new tools, different datasets, and different visual styles.

If you have questions, want to discuss ideas, or want help with your own project,
our door is always open.

You are always welcome in the Places & Flows Lab

Let’s keep learning, creating, and mapping together!

WY Breda

4 University
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